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Wordperfect x6 manual

WORDPERFECT OFFICE 2020 (version 20, released in 2020) [Page top] [WPO2020 released in May 2020.] Compare Versions (PDF - matrix version - WPOX6-WPO2020) Product Family (PDF) ([WPO2020-Edition Matrix] Product Family Comparison - Professional| Standard| Home &amp;amp; Students *) * As you might expect from reduced prices, Home
&amp; Student Edition doesn't have some features compared to Standard Edition — like WordPerfect eBook Publisher. Also (from footnotes on Corel PDF files): Home Edition &amp;amp; WordPerfect students do not include the following features: PDF Import, PDF Form, eBook publishing, Metadata Removal, Bat Numbering, pleading paper, Pleading
Expert, Table of Authorities, document review or routing slip. Note, however, that it can create PDFs – it cannot import them for editing. It can also be legally installed on up to 3 computers in your home. It can offer cheap upgrade paths. System requirements (from the Corel website): Windows 10*, Windows 8.1 or Windows 7 with the latest 1 GHz or faster
update/service pack (x86) or 1 GB RAM AMD64 processor (x86) or 2 GB RAM (AMD64) 2.75 GB hard disk space for application files 1024 x screen resolution 768 Mouse or tablet DVD drive (Required for box installation) Microsoft Internet Explorer 11 or higher ----- *WordPerfect Office 2020 supports Windows 10, version 1909 and later that may be released
during the WordPerfect Office 2020 lifecycle What's included: See the Corel website. From the matrix version above and from the WP2020 User Guide: WordPerfect Office 2020 New Features: • Add an EPUB Export filter • Save WordPerfect files to OpenDocument Text (ODT) • Set default magnification levels for new Quattro Pro spreadsheets* • Automatic
scale of app controls and toolbars in WordPerfect and Quattro Pro to your system's DPI settings* Office 2020 Advanced/Improved Features: • Reveal Code now shows table row and cell formatting codes • Jump to footnotes/endnotes when clicking the number; tooltips [new in WPX9] now also displays shortcut keys for jumping to notes • Enhanced options in
Tools, Settings, Display to display ToolTips on Footnote/Endnote numbers in document text (all tips now show [Ctrl + click to open footnotes [endnotes])• Increased number of default QuickWords • Improved PDF support allows resolution control of linked and embedded content in files Published to PDF* • Enhanced label printing, table headers, etc.*•
Improved currency formatting in Quattro Pro* ----- * From WP2020 PDF WORDPERFECT OFFICE X9 User Guide (version 19, released in 2018) (CAUTION: This is NOT the same as 9, released in 1997) [Page top] [WPOX9 was released in May 2018.] Compare Versions (PDF – matrix version – WPOX5-WPOX9) Compare Product Family (PDF) (Edition
(Edition Matrix - Standard, Professional, Home &amp;amp; Students *) * As you might expect from reduced prices, Home Edition &amp; Students don't have some features compared to Standard Editions – like WordPerfect eBook Publisher. Also (from footnotes on Corel PDF files): Home Edition &amp;amp; WordPerfect students do not include the following
features: PDF Import, PDF Form, SharePoint support, eBook publishing, Metadata Deletion, Bates Numbering, Pleading Paper, Pleading Expert, Table of Authorities, document review or routing slip. Note, however, that it can create PDFs – it cannot import them for editing. It can also be legally installed on up to 3 computers in your home. It can offer cheap
upgrade paths. System requirements (from the Corel website): Windows 10, Windows 8.1, or Windows 7 SP1, in 32-bit or 64-bit, all with the latest Update and Service Pack 1 GHz or faster (x86) or AMD64 PROCESSOR 1 GB RAM (x86) or 2 GB RAM (AMD64) hard disk space 1.5 GB for application files 1024 x 768 screen resolution Mouse or tablet DVD
drive (Required for box installation) Microsoft Internet Explorer 11 or higher : See Corel's website. From the matrix of versions above and from the WPX9 User Guide: WordPerfect X9 New Features: • Adjust room character color in Reveal Code • Set scroll speed to select content • Apply sentence case capitalization to selected text [see also similar but
improved macros here] • Save a copy of the document to a removable drive connected to your computer* • Enjoy support for VBA 7.1 WordPerfect X9 Enhanced Features : • Enjoy greater compatibility with wireless presenters and printers • Ability to open hyperlinks and recognition • Restore files from backup • Maintain settings between sessions when using
the spelling and Grammatical checkers • Change line spacing (now included on the Property Bar)* • Make fit and wrap text (now included on main toolbar)* • Apply subscript and strikeout to text (now included in The Text Properties Bar)* • Tap larger toolbar customization • Disable review mode after applying reviewer feedback • Preview short form entries in
the Table of Authorities • See footnotes and endnotes (hover mouse on call number) ----- * From WPX9 PDF WORDPERFECT OFFICE X8 User Guide (version 18, released in 2016) (CAUTION: This is NOT the same as WordPerfect Suite 8, released in 1997) [Page top] [WPOX8 released in April 2016.] Compare Versions (PDF - Features by Version -
WPO8-WPOX8) Compare Product Family (PDF) (Matrix Comparison Editions – Standard, Professional, Home &amp; Students *) [* As you might expect from reduced prices, Home &amp; Student Edition does not have features compared to Standard Editions – such as the WordPerfect eBook Publisher. Also (from a footnote on that PDF file): it is):
&amp;amp; The Student Edition of WordPerfect does not include the following features: PDF Import, PDF Form, SharePoint support, eBook publishing, Metadata Removal, Bates Numbering, pleading paper, Pleading Expert, Table of Authorities, document review or routing slip. Note, however, that it can create PDFs – it cannot import them for editing. It can
also be legally installed on up to 3 computers in your home. This can offer a cheap upgrade path.] System requirements (from the Corel website): Microsoft Windows 10, Microsoft Windows 8.1, Windows 7 (32-bit or 64-bit edition), with the latest service packs and updates installed 1.5 GB hard disk space for applications files 1 GB RAM (x86) or 2 GB RAM
(AMD64) 1 GHz or faster (x x86) or AMD64 1024 x 768 processor resolution Monitor Microsoft Internet Explorer 11 or higher DVD drive (required for box installation) Mouse or tablet with stylus †Internet connection may be required to verify serial number during installation. What's included (from the Corel website): WordPerfect Main Application® Quattro Pro
word processor® Presentation spreadsheet program™ WordPerfect slideshow maker® Lightning™ AfterShot digital notebook™ 2 RAW photo editing software Also includes 900+ TrueType fonts 10,000+ clipart images 30+ 175 templates + digital photo BrainStorm training video * The Pocket Oxford English Dictionary WordPerfect® Address Book
Presentation™ Graphics - bitmap editor and WordPerfect XML drawing application Project Designer Batch Conversion Utility to convert Microsoft Word documents to WordPerfect documents * New internet connection required for X8 [From feature matrix by Version above:] • APA, MLA and Turabian Writing Templates (among others). • Undo level increase
[is: default=10, max=300; now: default=50, max=300] • [New macro:] Function Key Keyboard Template Macro [named CreateFunctionKeyTemplate.wcm] - to create your own printable F-Keys keyboard template. • Dock Reveal Codes to the Left, Right or Bottom [accessed via a single toolbar button] • PDF formatting code (see website for WordPerfect
Reveal Codes Chart) • Template Preview [accessed via The New File from Template menu] with over 150 free templates included. [Note that the standard installation seems to place such extras in a special location - the C:\Users\Public\Public Documents\WordPerfect Office folder tree, in 13 subfolders.] These templates are not automated like many
WordPerfect Projects [accessed through the New Files from Project menu] but because they spawn new documents, you can easily enter your own personal information in the resulting document. Other: • Lock the toolbar: Right-click on the toolbar or property bar and you can lock/unlock everything in their current location. prevent accidentally dragging the
toolbar or property bar from its preferred property bar • Number of characters (Tools, Word Count -or- Files, Properties): Now includes counting characters with and without spaces. • [From WPOX8 User Guide:] Scaling (DPI)... dialog boxes, such as Open, Save, and Save As, now respect Windows font scaling (DPI). The icons and text in the dialog box now
increase or decrease the size along with the Windows icons. This ensures that the UI elements scale correctly and look crisp and legible on the screen of all resolutions.... [Tip: You may be able to change the resolution scaling for the toolbar a little further just for WordPerfect on high resolution screens by making small (reversible) changes to the program
startup icon. See my post on WordPerfect here (05-07-2018).] • [From press release:] Enhanced! Microsoft Office compatibility: Works with the latest Microsoft Office file formats for seamless file compatibility. WordPerfect gives you a great experience in Windows 10, 8.1 and Windows 7. [No details given.] WORDPERFECT OFFICE X7 (version 17, released
in 2014) [Page top] [WPOX7 released in April 2014.] Note: WordPerfect Office X7 (fully patched to at least Service Pack 2 — aka build number 17.0.0.366, released in May 2015) is certified by Corel to work with Windows 10. WPOX7 builds were previously certified for Windows 8/8.1. [* As you might expect from reduced prices, Home and Student Editions
don't have some features compared to Standard Editions — such as WordPerfect eBook Publisher. Also (from a footnote on that PDF file): The WordPerfect X7 application in WordPerfect Office X7 - Home and Student Edition does not include the following features or functionality: IMPORT PDF, PDF Form, SharePoint support, Metadata Removal, Bates
Numbering, pleading paper, Pleading Expert, Table of Authorities, document review or routing slip. Note, however, that it can create PDFs – it cannot import them for editing. It can also be legally installed on up to 3 computers in your home. This can offer a cheap upgrade path.] New to X7 [From Matrix Update above:] • Open more than 9 documents in a
WordPerfect session. Tip: • Even when you open more than 9 documents, only the last 9 will appear in the list at the bottom of the File menu, with the most recent at the top of that list. • However... when more than 9 documents are open, you can use the Program window menu option to Cascade or Tile. Or (in WPX7 and later) you can use the More Windows
option that appears in those menu options to bring up additional dialogs listing all the file names of your currently open documents; You can then select what you want to work on from the dialog. • Related tips: Clicking in the area of the main editing screen that has been nested or the tile will bring it forward. Then you can use Separate on the Windows menu
to send files to a separate new WordPerfect instance [multiple instances introduced in WPX6]. This may be a useful way to isolate just what you want to work on at the moment, as individual instances can be dragged to different (i.e., split) locations on your desktop screen. • Create Document thumbnails to view in Windows Explorer. [From the program's
User Guide, in order of appearance]- • You can do a Help search, or a Web search, directly from within the Reference Center. • Quick reference cards – tips and insights on a variety of topics. • You can create eBooks in EPUB format in addition to MOBI format. • WordPerfect lets you save documents to WPD, DOC, DOCX, PDF, and HTML5 simultaneously.
[See new macro below, Save To Multiple Format.wcm.] • When you save the file iteration, the updated version of the file is saved with the version number added to the file name. [See new macro below, Store.wcm Numbered. See also NewFN# macros in the multi-save macro set here.] • You can add files to your Favorites list and open those documents,
individually or in groups, using the Favorites Launcher [a new toolbar button (the icon is a yellow star) on the WordPerfect toolbar]. You can also manage your Favorites list. [This feature can also be accessed directly through the new macro below, Favorites Launcher.wcm.] • Mail Merge Expert [on the Tools menu, on the standard &lt;WordPerfect
menu=&gt;] is designed to simplify merging addresses with letters, labels, and envelopes. It guides you step by step through merging, from selecting data sources containing recipient information (DAT files) and form documents that have consistent content (FRM files) to merge outputs. You can use a variety of webmail address books that are in CSV format
in a merge, but you must first convert them to a DAT file. • You can [...] print all open documents or just the page where the cursor is positioned. [See new macro below, PrintAll.wcm. See also PrintAll macro here.] • You can create fillable PDF forms, which you can distribute to collect certain information from users. You can add form controls to PDF forms
[from the Insert menu], such as text fields, check boxes, drop-down lists, list boxes, and radio buttons. • You [can] publish documents to HTML5. • You can manage macros from multiple locations using Macro Manager [new button on standard WordPerfect toolbar; see also new macro below, Macro Manager.wcm]. It provides a description of the file, the date
of the last compiled version, and a preview of the code. You can also run or edit macros from Macro Manager. [NOTE: More information about the macros below can be via Help button (F1) : Search Using the macro that came with WordPerfect.] • [New macro: Count Spaces.wcm] Displays the amount &lt;/WordPerfect&gt; &lt;/WordPerfect&gt; in documents,
including or excluding space characters, and including or excluding sub-documents. • [New macro: Calculate words.wcm] Counts all instances of a word or phrase in a document and generates a file that shows the frequency in the current document. [See also WordList macro here.] • [New macro: CSVtoMerge,wcm] Converts contacts exported to a CSV file
from a gmail.com, outlook.com, or yahoo.com to a WordPerfect merged data (DAT) file. • [New macro: Favorites Launcher (on the WordPerfect toolbar)] Open favorite documents, individually or in groups, and let you manage your Favorites list. • [New macro: KeystrokeMenu.wcm] Launches The Keystroke Menu, a searchable list of WordPerfect functions
that lets you quickly find and perform actions. • [New macro: Lorem Ipsum.wcm] Generates lorem Ipsum sample text, and inserts it into the current document. • [New macro: Macro Manager.wcm] Starts Macro Manager, which is a browser that lets you manage macros. • [New macro: Numbered Storage] [See When you save the iteration ... above.] • [New
macro: PrintAll.wcm] Prints all open documents. [See also PrintAll macro here.] • [New macro: ReplaceInFolder.wcm] Replaces a word or phrase in all WPD and WPT files in a folder. • [New macro: Save To Multiple Formats.wcm] Lets you save the current file to WPD, DOC, DOCX, PDF, and HTML5 simultaneously. • [New macro: SendToTextBox.wcm]
Moves the currently selected text into the selected character text box. • [New macro: Thumbnail Current Page.wcm] Embeds thumbnails of the current page in a viewable document in Explorer. WORDPERFECT OFFICE X6 (version 16, released 2012) [Page top] WPOX6 was available as a Corel download on April 26, 2012. The retail version (box) was
available in early May 2012. The download version is the same as the retail box version; however, you will need to download extras (fonts, etc.) using corel information will send you an email after you purchase and register the main set of programs downloaded. Note: WordPerfect Office X6 (patched to at least Service Pack 1 — aka build number 16.0.0.388,
released in August 2012) is certified by Corel to work with Windows 8/8.1. The patch file can be found on the Corel site under the Support tab and must be applied in numerical order. See also - What interesting surprises can be found in Corel® WordPerfect® Office X6? WordPerfect X6 – Some observations – post on WordPerfect Universe by Barry
MacDonnell. Matrix comparison edition (PDF) of Standard, Professional, Home &amp;amp; Student, and Legal Ed. [Current as of June 2013.] Reviewer Guide (PDF) [Note: Comparison on p.14 has been replaced by the Edition comparison matrix above.] Updating the matrix (PDF) - comparing features in WordPerfect version 8 – X6; for more details on
specific versions, see see Corel's downloadable PDF guides (Handbooks, Handbooks, Macro Guides) are OfficeCommunity.com here. WORDPERFECT OFFICE X5 (version 15, released in 2010) [Top page] Note: WordPerfect X5 (fully patched) is certified by Corel to work with Windows 7. The patch file (Service Pack) can be found on the Corel site under
the Support tab. Review Guide (PDF file): Version comparison (PDF file). (For the WpX5 Professional Edition, see here.) Corel's WordPerfect X5 Matrix Upgrade – overview (table) of key features found in WordPerfect version 8-X5; for more details on specific versions, see below. What's New in WordPerfect® Office X5? (Page corel) WORDPERFECT



OFFICE X4 (version 14, released in 2008) [Page top] See Corel Launch WordPerfect® Office X4 – The World's First PDF Office Suite. PC Magazine reviewed it here. See the Corel Reviewer Guide (2.28 MB in PDF format). See comparison charts (PDF format) between four editions. WORDPERFECT OFFICE X3 (version 13, released in 2005) [Page top]
From the Corel Reviewer Guide: Summary of New and Improved Features (Standard Edition; see below for other editions) Built-in publications up to PDF capabilities make it easy and cost-effective to share WordPerfect Office documents while maintaining control over content and views. With WordPerfect, Quattro Pro, and Presentations, it's easy to
exchange information with Microsoft® Office users thanks to improved compatibility with Microsoft Office file formats. Easier to use thanks to a more familiar and intuitive environment with newly updated and stylish buttons and toolbars that now support windows® the default THEME XP. PerfectExpert is enhanced™ provides easy access to a variety of
project templates and, if requested, provides helpful advice for almost any project. Improved multilingual character support ensures that expanded characters are displayed accurately. Finding the right template has never been easier with the improved WordPerfect® OfficeReady™ template browser. Improved Migration Manager makes it easy to keep
settings from previous Installations of WordPerfect Office. Now accessible from the Start menu, Presentation™ Graphics X3 is tightly integrated with WordPerfect®, Quattro Pro®, and Presentation™. Enjoy email, calendar, contacts, spam protection, and lightning-fast search capabilities with the new WordPerfect® MAIL™. With WordPerfect Office X3 -
Professional Edition only, take advantage of improved desktop database applications® - relational desktop database applications. WordPerfect® X3 New ability to Import PDF files with WordPerfect® X3 makes it easy to re-use text and graphics from PDF files without additional purchases. Publish To PDF feature now converts WordPerfect table of contents
titles into PDF bookmarks for easy PDF navigation. Access online resources and quickly perform Web searches The new WordPerfect® Online Resource that displays the Yahoo!® Search. Quickly gain more control and access to improved Word Count features by using the new Count button on the app bar. Enhanced Document Routing makes it easy to
collect feedback from multiple collaborators. Improved integration with WordPerfect® MAIL™ makes it easy to share the WordPerfect EMAIL address book with WordPerfect to create routing slips to use for document routing. Easily repurpose HTML content with the improved Paste Without Formatting feature. Now, you can view and print WordPerfect
documents from a Web browser. Quickly and easily remove confidential or sensitive information from documents with the new Save No Metadata feature. New label formats are available from industry-leading suppliers. Quattro Pro® X3 Share spreadsheets and charts with any computer user with Adobe® Reader® software, thanks to the new Publish To
PDF feature. Create polished, professional-looking reports with enhanced CrossTab reports, which now maintain connections with ODBC databases. Easily apply advanced rendering to charts with enhanced charting tools. Presentation™ X3 Enhanced Publish To PDF feature now translates slide names into PDF bookmarks for easy PDF navigation of
presentations and slide shows. Use the new Master from the enhanced Master Gallery to create professional-looking slide shows and presentations without having to design from scratch. Show off presentations with smoother, rounder text and images, thanks to anti-aliasing interpolation and enhanced graphics. What's Included with WordPerfect® Office X3
(See also Differences in the WPO X3 Product Family) - Standard Edition: WordPerfect Main App® X3: This powerful word processing app provides capabilities that simplify your work. Easy to use and highly compatible with Microsoft® Word, WordPerfect X3 provides all the tools you need to create dynamic documents that are easy to share with other
computer users. Quattro Pro® X3: Featuring improved compatibility with Microsoft® Excel, this powerful spreadsheet app can help you organize, analyze, report, manage, and share important financial data and information. Quattro Pro X3 provides easy-to-use charting features and advanced rendering options that give your information a professional and
polished look. Presentation™ X3: With improved compatibility with Microsoft® PowerPoint®, X3 Presentations includes all the tools you need to create slideshows, project proposals, interactive reports and demonstrations, multimedia presentations, flyers, signs, and more. For easy sharing, you can publish projects to HTML or Macromedia Flash™. Plus, the
standalone presentation technology, Show On The Go™, lets PC users see your projects — whether they're using Presentations or not. WordPerfect® MAIL™: With lightning bolts WordPerfect MAIL finds buried information based on years of inbox, contacts, or calendar clutter. In addition to email, calendaring, and contact management, this fully-fied and
easy-to-use app includes innovative archiving capabilities and exceptional spam protection. Presentation™ Graphics X3: Over the years, this easy-to-use graphics tool has been closely integrated with WordPerfect Office. Now more accessible than ever, you can select X3 Graphic Presentation from the Start menu to create and edit original images and
images. With support for many commonly used file formats, Presentations Graphics X3 ensures that you can re-use your graphics with other products. WordPerfect Support Utility® OfficeReady™ Template Browser: This template browser makes it easy to find the right template for any project. This provides a thumbnail view of available templates that open
with a single click. WordPerfect® Office Conversion Utility: WordPerfect Conversion Utility® Office makes it easy to convert batches of any type of document that WordPerfect can open. For example, you can convert the entire folder structure of a Microsoft Word document to WordPerfect. PerfectScript™: PerfectScript™ developed specifically for
WordPerfect Office applications to help you create macros, records, and scripts. QuickFinder™: QuickFinder™ is an advanced utility that lets you find files by performing highly customizable searches. Pleading Expert: Pleading Expert is a step-by-step guide that helps you create a pleading cover sheet. It guides you through page settings, margins, fonts,
lines, footers, and signatures, and lets you easily save pleading styles that you can reuse. – Additional Applications in Professional Edition: Paradox®: File-based relational database application Paradox® lets you store and retrieve data in a variety of ways. To help you track, organize, and compile data, this complete desktop database solution stores
information in powerful, searchable tables. Microsoft® Visual Basic® for Applications: Microsoft® Visual Basic® for Applications enable developers to build custom business solutions by automating and integrating off-shelf software applications to meet specific customer needs. Software Developer Kit (SDK): With Professional Edition, SDKs are included to
simplify software deployment and maintenance. – Additional Resources in Professional Edition: WordPerfect® Office X3 Deployment Guide: Included as a PDF file, this step-by-step resource simplifies network usage. WordPerfect® Office X3 Programming Guide for VBA: Included as a PDF file, this new manual resources to develop and distribute Microsoft
Visual Basic for Applications solutions. Apply Macros and Templates: Included as a PDF file, this guide provides useful information about sharing macros and templates with others Office X3 users. – Content: WordPerfect Office X3 includes 9,500 clipart images, 175 photos, and 900 TrueType fonts. – Documentation: The help file now provides Zoom In and
Zoom Out buttons so you can adjust the screen size. PerfectExpert™ 256-page printed user guide (retail version of WordPerfect Office X3 - Standard Edition) The user guide is also included as a PDF. – Minimum System Requirements: Windows® XP (Home or Professional Edition with the latest Service Pack), Windows 2000 (with the latest Service Pack),
or Windows 98 SE 128 MB RAM (256 MB recommended) 466-MHz processor (Pentium® III or equivalent processor recommended) 575 MB of hard disk space for minimum Super VGA installation, 16-bit color monitor with 800 × 600 or larger resolution CD-ROM drive Mouse or tablet Microsoft® Internet Explorer 5.5 or later versions Compare WordPerfect®
Office X3 Editions WordPerfect® Office X3 - WordPerfect Standard Edition Office X3 - Standard Edition includes wordPerfect X3 trusted power for word processing, Quattro Pro X3 for spreadsheets and charts, X3 Presentations for multimedia slideshows, WordPerfect MAIL for communication, and X3 Presentation Graphics for creating and editing original
images and bitmaps. Additionally, Pocket Oxford™ English Dictionary, Legal tools, and the WordPerfect OfficeReady template browser are included. Highly compatible, it is the number one alternative in the world to Microsoft Office. WordPerfect® Office X3 – Professional Edition WordPerfect Office X3 – Professional Edition is ideal for customers who need
advanced database functionality, or who have complex or customized installations. This includes everything in Standard Edition, except for WordPerfect MAIL. It also includes Paradoxes for relational databases, Microsoft Visual Basic for Applications, and Software Developer Kits (SDKs). In addition, The Professional Edition includes network deployment
guides, template and macro guides, and VBA programming guides. The openness of WordPerfect file formats makes it easy for vendors to open and create WPD files. You can also create custom Dynamic Link Libraries (DL) to automate and integrate applications with WordPerfect Office. WordPerfect® Office X3 – Student and Teacher Edition An A+
alternative to higher-priced products, WordPerfect Office X3 – Student and Teacher Edition is perfect for students and educators. Licensed for noncommercial use, it includes WordPerfect X3 for word processing, Quattro Pro X3 for spreadsheets, X3 Presentations for multimedia slideshows, Paradox for relational databases, and Presentations Graphics X3
for bitmap graphics creation. Plus, Pocket Oxford English Dictionary and The WordPerfect OfficeReady template browser are included. In addition, student and teacher edition for use of up to three PCs per per (See Home and New Student Editions below.) WordPerfect® Office X3 – Home Edition Designed with specific home computer users in mind,
WordPerfect Office X3 – Home Edition provides eight leading home PC tools in one complete package. These include WordPerfect X3 - Home Edition for word processing, Quattro Pro X3 - Home Edition for spreadsheets and charts, two collections of WordPerfect OfficeReady templates, Corel® Photo Album™ 6 – Standard Edition for managing digital photo
collections, Pinnacle Studio™ SE for home video editing, Pinnacle Instant CD/DVD LE v8 for burning CDs and DVDs, and Norton Internet Security™ 2006 for protection from viruses and other threats. This compatible, feature-rich and value-packed suite ensures to make your entire household computing experience more enjoyable, creative, and secure.
(See Home and New Student Editions below.) WordPerfect® Office X3 – Home and Student Edition (released August 2007) For more information see Corel's press release (August 27, 2007) here. WORDPERFECT 12 (released in 2004) [Page top] WORDPERFECT 11 (released in 2003) [Page top] From Wordperfect Help file: What's new in WP11:
Publishing to XML - Lets you publish new and existing WordPerfect documents to the WordPerfect Classic Mode XML format - Lets you change your keyboard and environment to WordPerfPerf 1 5.1 Color and keystroke scheme Document tracking – Allows you to automatically route documents to other users using Outlook Document maps – Lets you
navigate complex documents Revealing Code printing – Lets you print documents with code available for easy troubleshooting conversion utility – Allows you to quickly convert documents to Other WordPerfect formats – New check box in Insert, Header/Footer allows syncing of new headers or footers with document margins in those locations. What's
different in WP11: • Publish to PDF – Now supports Acrobat 5.0 • Variables – Upgrades to variable features make it easier to store, retrieve, and re-use documents • Legal tools – Lets you create custom defense templates, capturing case data, and publishing documents directly to EDGAR • Outlook Address Book – Lets you access data directly from the
Outlook address book • RealTime Preview – Even more document modifications now work with RealTime Preview • Reference tools – The newly designed user interface makes creating reference tools easier IMPORTANT: The original release of WordPerfect 11 (that is, version 11.0.0.233 as shown in Help&gt;About...) introduced a bug that caused some
macros to be created/edited/played in it (no matter who made it) to fail correctly when played in WP11.0.0.300, and vice versa. These macros appear to be rotated but do not return to the main document screen and appear to hang, or they go into endless loops. This issue also affects Corel's sending macros and and macros within various Corel Projects. For
solutions, see here. WORDPERFECT 10 (released in 2001) [Page top] What's new in WP10: Align and distribution tools – Lets you align and distribute objects with respect to themselves and pages. Automatically suggest a file name - When you save a document for the first time or as a new file, WordPerfect automatically inserts the suggested file name.
Document review margin markers - Allows you to add indicators in document margins to let authors know that text has changed. Improved HTML publishing with Cascading Style Sheet (CSS) support - Allows you to convert WordPerfect documents for use on the World Wide Web by using increased flexibility and advanced page layout and CSS support
formatting. Print a list of keyboards - Allows you to print a copy of keyboard shortcuts. You can export the list to a file, and you can also customize the list. Select sections – Lets you select pages, secondary pages, chapters, and volumes. Table to text - Allows you to convert a table to delimited text. Text to a table - Allows you to convert document text to a
tabular format, based on user-defined delimiters. Toolbar and property picker - Allows you to select options to underline, undo, or repeat, add drop capital letters, and other formatting options. Two-page view – Supports Revealing Code and writing tools. Variables – Lets you enter variable placeholders into documents and change content later, updating all
instances of variables. Zoom Tool - Lets you zoom in on specific areas of the document. With each new version of WordPerfect, certain items are refined, others are renamed, and still others are found in new locations. The following table shows items that have changed in WordPerfect 10. What's different in WP10: App bar – you can now display the current
language in the app bar (for example, UK-US. (USA)). You can change the language by accessing the app bar. Comments – The enhanced comment bubble is less annoying, fits only the length of the text, and leaves no free space in the bubble. You can also apply formatting to text, as well as insert graphics, tables, and so on, inside the comment bubble.
Corel RealTime Preview - This feature has been expanded to include QuickFont, underline, drop capital letters, and other formatting features. Merge – The Merge feature now allows more fields for each enhanced record and keyboard merging dialog. Navigation - The Go to now feature includes bookmarks, hyperlinks, red striped text, graphics, and other
items. The Search by feature has been expanded, and flyouts let you choose your search method faster. Publish to PDF - Supports hyperlinks and watermarks. Ruler - Elements (for example, left margin adjustments) have been redesigned and enlarged. Table - The Tables menu has been added to the menu bar. Cells that contain formulas are marked with
Indicators. You can also copy a cell formula by dragging. The QuickSplit Columns and rows button on the property bar lets you split cells into four cells (columns and rows). The Shadow Cursor now works in table cells. Text selection – You have more flexibility in selecting text with your mouse or keyboard. IMPORTANT: The new features introduced in
WordPerfect 10 affect [1] how text is selected and [2] how the cursor moves — and can also generate serious problems with some macros in WordPerfect 10 and later versions. This is the result of setting a new checkbox in Tools, Settings, Environment: Use WP9 text selection. Factory setting OFF (check box unchecked) by default — it may be for the
convenience of Microsoft Word users so that the program acts the same way when selecting text. Most users of earlier versions of WordPerfect may want to enable it. WORDPERFECT 9 (Released in 1999; rewritten in 2000 and released as WordPerfect 9 -Service Pack 4) (CAUTION: This is NOT the same as WordPerfect X9, released in 2018) [Page top]
Initial release: May 1999. Important: WPO9(sp4) was released in September 2000 and is only available directly from Corel. This is an almost complete rewrite of the program – that is, it is not an ordinary patch – so it cannot be downloaded and used to update the initial WP9 release (even if that version is already patched to SP3). What's new in WP9: Corel
RealTime Preview Corel RealTime Preview performance and productivity features let you scroll through and preview several different formatting options, such as fonts, lines, tables, borders, and shading, to see how they look, without applying those changes to your document. Install-As-You-Go Install-As-You-Go helps you minimize the hard disk space
required by WordPerfect Office 2000 applications by including only naked needs. If an item that isn't installed is selected, you'll be asked if you want to install it. Embedded WordPerfect 9 fonts let you use the Embedded font feature. If you select Pinned Fonts when you save your document, your fonts are compressed and saved with file data. Now your
favorite fonts will go wherever your files go for the presentation you expect. Autoscroll Autoscroll lets you scroll through documents without using the arrow keys or scroll bar. When you point the Autoscroll arrow in the direction you want to move, you can scroll the document. The scroll speed increases as you move the arrow further from the Autoscroll tool
and slows down as you move the arrow closer to the Autoscroll tool. Block-Make-It-Fit WordPerfect 9 enhances make-it-fit features available in previous versions to allow you sections of your document into a certain number of pages without affecting other areas where the specifications fit may differ. Enhanced Enhanced Improved charting modules provide
additional charting types and capabilities. WordPerfect 9 improved accessibility continues to work toward accessibility requirements, including High Contrast mode support, providing keystrokes for most features, using standard user interface controls that make Third-Party accessibility tools compatible with Corel applications, support large font modes, and
provide options under settings to provide flexibility in functionality. WordPerfect 9 enhanced shapes provide more than 100 new shapes. You can select shapes from the new shape palette or use the Basic Shapes, Arrows, Stars, Banners, and Flowchart tools. The Actions button requests action assignment; The outgoing call shape has a pointer that can dock
anywhere in the document. All shapes have a new Text In Shapes feature, which allows text to be quickly added to a shape. Visual Basic for Applications Integration Visual Basic for Applications (VBA) lets you develop VBA applications to control WordPerfect 9 through the OLE Automation Type Library. The main object exposed by WordPerfect 9 is the
PerfectScript object, which consists of all the functions currently available in the PerfectScript language, making it easy for those familiar with PerfectScript to modify existing scripts and to understand the syntax and parameters needed to program the PerfectScript object method. These VBA projects are stored in application documents and are easy to
distribute. Italic table cells You can skew the top row or the left or right column of the table. Unless you specify otherwise, any text you type in italic cells will also be italic. You can also change the skew angle and specify other leaning options. WordPerfect 9 enhanced multiple-page printing includes additional options for printing multiple pages. You can
specify the number of copies you want to print and whether you want them to be arranged. Collage is useful when printing multipage documents. When you enable the Collage check box, a full copy of each document is printed before the next document is printed; when the collage is disabled, all copies of the first page are printed before the second page
copy is printed. Print Preview Although WordPerfect 9 creates a document in a WYSIWYG environment, many users have requested the Print Preview option. WordPerfect 9 lets you view your document as a single page or a double page. Print Preview is fully compatible with Corel RealTime Preview, which lets you experiment with formatting options, such
as fonts, lines, tables, borders, and shadows, without applying them to your document. Print Preview is also fully editable; therefore, you do not need to return to regular view to make changes to your document. Browse button Browse button makes navigation in more documents WordPerfect 9 lets you navigate documents the same way you navigate internet
documents. WordPerfect 9's enhanced file conversion and integration features continue to use the same file formats as their predecessorsCorel WordPerfect 6, 6.1, 7, and 8with those that require any conversion from previous versions. Keeping the same file format allows you to convert Microsoft Word and Lotus AmiPro documents while keeping all
document data from being open for storage. In-Place Editing lets you edit objects without switching to another window. The buttons and list boxes temporarily change to work specifically with the object. WordPerfect 9 On-Premises Activation now uses the new In-Place Activation feature to help further integrate Third-Party apps into Office 2000 WordPerfect.
By double-clicking an OLE object, the object's native editing or development environment starts inside WordPerfect, providing seamless integration of 3rd Party applications. XML XML (eXtensible Markup Language) capabilities provide an application-independent platform and environment for determining document architecture and document markup.
WordPerfect 9 lets you create, validate, and store XML documents in familiar WYSIWYG environments. The structured tree view, shown in a separate window, provides a complete document layout that is easy to read. WordPerfect 9 automatically inserts and maintains tag pairs to create XML files. WordPerfect 9 provides an editing environment that includes
guidance, automatic insertion of elements, and automatic document creation, which makes document creation quick and easy. You can customize menus, toolbars, and keyboard mappings to create your own work environment. WordPerfect 9 combines Document Type Definitions (DTDs), layout information, and mapping files into a single WordPerfect
template. For more information about XML, see WordPerfect Online Help. WordPerfect 9 SGML Editor lets you create SGML documents in familiar WordPerfect environments. WordPerfect 9 lets you edit, mark text, and validate tags in SGML documents. You can also use WordPerfect 9 stationery, such as Spell Check and Quick Correction. You can hide
SGML code in the document window and use WordPerfect 9 text formatting to make SGML documents easier to read on the screen. The SGML editor also provides the following capabilities: document structure display, giving WYSIWYG views on one side of the screen and tree view on other enhanced graphics that let you import and export markup with the
SGML document authoring tool comparing automatic mapping features for Standard Organization characters (ISO) during the DTD compilation process to map multinational characters to the appropriate characters in the SGML Editor. Manual character mapping is not included in the ISO character set. Enhanced Enhanced and exporting the Internet
capabilities of the SpeedLinks SpeedLinks feature lets you create linkshighlighted Internet text in World Wide Web documents that help you jump to other parts of the same document or to other documents on the World Wide Web. When you type text that starts with www, ftp, http, or mailto, SpeedLinks automatically converts the text to an Internet link.
Teralix 2 Teralix 2 integration lets you create and organize professional and effective documents that can be published to HTML. Teralix can make long and complicated documents easy to understand and navigate; Integrated navigation maps let you visualize and quickly access any part of your document. Teralix documents resemble web pages, with easy-
to-create links, and you can add spreadsheets, graphs, and other files. What's different in WP9: With each new version of WordPerfect a certain item is added, another is renamed, still another one is found in the new location. Items renamed or moved in version 9 are: QuickSpots QuickSpots QuickSpots provides direct access to editing features for specific
objects in the document, such as paragraphs or tables. WordPerfect 9 enhances this idea by including more than 20 different Property Bars that appear when you click a specific object. The Property Bar changes to suit your immediate needs. For example, click a table, and the Property Bar displays buttons for the table editing tools. Click the graphic, and the
Property Bar displays the graphical editing tools. PerfectExpert WordPerfect 9 comes with its own built-in expert, ready to help you with any task. PerfectExpert includes the best features of Quick Tasks, templates, and Coaches, combined with information from online Help and the power of a natural language interface to help you with everyday tasks.
PerfectExpert lets you quickly create complex documents using professionally designed templates. The Menu menu in WordPerfect 9 has undergone a significant restructuring to improve access to the most frequently used features. The menu is also standardized across Office 2000 WordPerfect apps to make learning easier for each app. Right-click the
menu to choose a menu similar to the menu you used in previous versions of WordPerfect. The Tables and Graphs menu is no longer available; editing features for tables and graphics are now available in the Property Bar. Click the table or graphic to display the Table or Graphic Properties Bar. File menu, Publish As and File, Send consolidated as File,
Send To. Outline Features and &amp;Points; Numbering consolidated in Insert, Outline/Bullet &amp;&amp; Numbering. The abbreviation feature is renamed to QuickWords and moved to Tools, QuickWords. Help used to access technical information and additional products, renamed the Corel Web site. The Initial Document style is renamed and moved to
Document, Current Document Style. The Initial Document font is renamed and moved to File, Document, Default Font. Edit level stylesWhen you organize text using bulleted lists, numbered lists, and outlines, you can create level styles. For example, you can create a style that formats all second-level headings in bold italics. In WordPerfect 9, you can edit a
level style that you've created, but you can't edit any of the preset styles provided with WordPerfect. WORDPERFECT SUITE 8 (released in 1997) (CAUTION: This is NOT the same as WordPerfect X8, released in 2016) [Page top] [Initial release: 1997. WPO8/sp7 was released in December 1999. (Note: Two patch versions of SP7 are available — one of
which is for Legal Edition only. Users are warned to use the correct patch for their Edition.] What's New in WP8: Corel WordPerfect Suite 8 adds an updated and more intuitive user interface to classic products. The new context-sensitive Property Bar, updated toolbars, and simplified dialog boxes provide a highly tuned and intuitive work environment. This
innovative and powerful context sensitive Bar Property Bar changes depending on the task you perform. For example, while you're working on a table, the Property Bar displays a table tool. When you select a graphic, the Property Bar changes to a graphic tool. The powerful new App Bar App Bar lets you switch between documents, drag and drop
information, and easily work with multiple documents. Corel PerfectExpert The Corel PerfectExpert combines the best features of QuickTasks, templates, Help, and Coaches to help you get your work done faster. Corel PerfectExpert can walk you through detailed projects like creating resumes (even if you want to use another suite of apps to create
document sections), or can walk you through smaller tasks like inserting clipart images. Corel PerfectExpert gives you a professionally designed document gallery to choose from, and you can change the layout and content in a variety of ways to meet your needs. HTML Support With the addition of HTML form support, Corel WordPerfect continues to lead the
industry in Internet publishing technology. Using Internet Publisher, you can add form fields to your web document. These fields include radio buttons, checkboxes, list options, and text boxes, making information collection easier than ever. You can insert sound clips, image maps, and even Java applets to make your pages interesting and easy to navigate.
Corel WordPerfect supports HTML 2.0 and 3.2 specifications, and includes some additional browser-specific tags recognized by Netscape Navigator Netscape Communicator 4.0 and Internet Explorer version 3.0 and higher. WordPerfect's Corel QuickLinks pioneered the ability to link text to documents and bookmarks with Hypertext features. Corel Corel 7
adds the ability to link to Uniform Resource Locator (URL) on the Internet. Corel WordPerfect 8 continues to enhance this capability with the QuickLinks feature. When you type text that starts with www, ftp, http, or mailto, QuickLinks automatically converts it to an Internet link. You can even modify QuickLink to convert links to more meaningful terms. For
example, as you type www.corel.com, QuickLink can replace visible text with Corel and create a link to the Corel home page in the . Intel MMX Support Corel WordPerfect Suite 8 is the first software suite to support Intel Pentium with MMX technology. You don't need to have a computer equipped with MMX technology to run Corel WordPerfect 8. However,
MMX-enhanced computers can improve corel performance of WordPerfect by reducing the time it takes to rearrange bitmap and vector graphics and increase speed in other areas. The new Picture Layer Image Layer lets you draw graphic objects directly over text, group graphic objects, and arrange graphic object order. Create lines and shapes with
arrowheads, polygons, circles, and more. Add colors, gradient fills, and patterns to give your document extra polish. You can even draw on top of a clipart or chart that you have inserted into your document. Enhanced table tables have always been a hallmark of Corel WordPerfect. You can insert a table that spans a full page width, or only part of it. When
you click a table, the Table Properties Bar appears giving you one-click access to dynamically size rows within a table and quickly merges or splits cells with a single click and drag. QuickFormat easy-to-use formatting for tables. Just select the table cells that contain the formatting you like, select Quick Format, and apply the format to the cells you want to
change. Grammar-As-You-Go Corel WordPerfect 7 adds Spell-As-You-Go, a time-saving feature that lets you correct spelling errors as you type. Corel WordPerfect 8 adds Grammar-As-You-Go, another wordaving feature that lets you recognize and fix common grammar problems as you type. For example, phrases like they're at home are marked in a
document. Right-click the tagged phrase and choose from a list of possible suggestions, or ignore the flagged phrase and continue. Corel Version Corel's version solves the problem of trying to control and track multiple copies of the same file. Instead of trying to track all your updates to a file by saving its new version with a different file name, Corel Versions
lets you save the changes you've made to each successive version of your file. With Corel You can: Archive previous versions of files Take archived versions of files View archived versions of files Compare archived files to see the difference between them Attach meaningful information to each version that can be displayed in the Document history window
Track some users of common files Delete archived files from the history list Specify how many versions should be saved in the document history list Protect certain archived versions from being removed from the SGML Editor history list Using the familiar WordPerfect Corel environment, you can create new SGML documents, edit existing SGML documents ,
mark text, validate tags, and improve how your SGML documents are printed. You can also use the power of the WordPerfect Corel writing tool to check spelling and fix typing errors automatically with QuickCorrect. You can hide SGML code in a document window and use Corel WordPerfect text formatting to make documents easier to read on the screen.
Corel Provides WordPerfect: A structured view of a document that provides a WYSIWYG view of the document on one side and a tree view on the other. Improved graphics support so that graphics and markup associated with graphics can be imported and exported with SGML documents. Automatic mapping for ISO characters during the DTD compilation
process so that multi-national characters are mapped to the appropriate characters in the editor. (Characters not included in the ISO character set can still be mapped by hand.) Increased import and export to handle white space in SGML documents is better. Where did it go? QuickSpots QuickSpots provides direct access to editing features for specific
objects in a document, such as paragraphs or tables. Corel WordPerfect 8 enhances this idea by including more than 20 different Property Bars that appear when you click a specific object. The Property Bar changes to suit your immediate needs. For example, click a table, and the Property Bar displays buttons for the table editing tools. Click the graphic,
and the Property Bar displays the graphical editing tools. PerfectExpert trainers guide you through small tasks, such as creating headers, and demos show you an overview of specific features. But they didn't take into account the work you were trying to do at the time. PerfectExpert combines the best features of QuickTasks, templates, Help, and Coaches to
help you get your work done faster. PerfectExpert gives you a professionally designed document gallery to choose from, and you can change the layout and content in a variety of ways to meet your needs. Beginners will appreciate the way PerfectExpert provides a task-oriented approach to sometimes outstanding and complex applications. More advanced
users will love the flexibility and direct help PerfectExpert provides when they use the features in Corel WordPerfect to create complex documents. QuickFinder QuickFinder direct through the Open dialog box. Click Open File, and then specify the drive or folder you want to search. Inside text box, specify the file type (such as *.wpd) or the contents of the file
(such as Corel WordPerfect). Then, click Find. Click About QuickFinder for more information. The Insert menu has evolved to include several types of document objects such as tables, graphics, watermarks, equations, headers, and footers. The Tables and Graphics menu is missing and editing features for tables and graphics are now available in the
Properties Bar. Click the table or graphic to display the Table or Graphic Properties Bar. The File&gt;Publish as and File&gt;Send menus are consolidated as File&gt;Send to. Outline Features and &amp;Points; Numbering consolidated in Insert&gt;Outline/Bullet &amp;amp; Numbering. The abbreviation feature is renamed to QuickWords and moved to
Tools&gt;QuickWords. Help Online, which is used to access technical information and additional products, was renamed to the Corel Website. The Initial Document style was renamed and has been moved to &gt; Repeating Document. The Menu Menu menu in Corel WordPerfect 8 has undergone a significant restructuring to improve access to the most
frequently used features. Menus are also standardized throughout the suite of apps to make learning each application easier. Right-click the menu to choose a menu similar to the menu you used in the Corel version of WordPerfect.The previous Initial Document font was renamed and moved to Font File&gt;Document&gt;Default. [Top page] top]
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